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Información importante para el usuario
Las características de funcionamiento de los equipos de estado sólido son diferentes de las de los equipos electromecánicos. El documento
Safety Guidelines for the Application, Installation and Maintenance of Solid State Controls (publicación SGI-1.1 disponible en la
oficina de ventas local de Rockwell Automation o en línea en http://literature.rockwellautomation.com) describe algunas diferencias
importantes entre los equipos de estado sólido y los dispositivos electromecánicos de lógica cableada. Debido a esta diferencia, y también
a la amplia variedad de usos de los equipos de estado sólido, todas las personas responsables de usar estos equipos primero deben
asegurarse de la idoneidad de cada una de las aplicaciones concebidas con estos equipos.

En ningún caso Rockwell Automation, Inc. será responsable de los daños indirectos o resultantes del uso o de la aplicación de este equipo.

Los ejemplos y los diagramas de este manual se incluyen únicamente con fines ilustrativos. Debido a los numerosos requisitos y a las
numerosas variables asociadas con cada instalación, Rockwell Automation, Inc. no puede asumir ninguna responsabilidad por el uso que
se haga en función de ejemplos y diagramas.

Rockwell Automation, Inc. no asume ninguna obligación de patente respecto al uso de información, circuitos, equipo o software
descritos en este manual.

Se prohíbe la reproducción total o parcial del contenido de este manual sin la autorización escrita de Rockwell Automation, Inc.

Este manual contiene notas de seguridad en todas las circunstancias en que se estiman necesarias.

Allen-Bradley, ControlLogix, DataSite, FactoryTalk, FactoryTalk View ME, FactoryTalk View SE, PanelView, PanelView Plus, RSLogix 5000, RSLinx, Rockwell Automation y TechConnect son marcas comerciales 
de Rockwell Automation, Inc.

Todas las marcas comerciales no pertenecientes a Rockwell Automation son propiedad de sus respectivas empresas.

ADVERTENCIA
Identifica información acerca de prácticas o circunstancias que pueden producir una explosión en un ambiente 
peligroso, lo que puede provocar lesiones o incluso la muerte, daños materiales o pérdidas económicas.

IMPORTANTE Identifica información crítica para la correcta aplicación y comprensión del producto.

ATENCIÓN Identifica información sobre prácticas o circunstancias que pueden provocar lesiones personales o incluso la 
muerte, daños materiales o pérdidas económicas. Los mensajes de atención le ayudan a identificar los peligros 
y a reconocer las consecuencias.

PELIGRO DE CHOQUE Puede haber etiquetas en el exterior o en el interior del equipo (por ejemplo, en un variador o motor) para advertir 
sobre la posible presencia de voltaje peligroso.

PELIGRO DE QUEMADURA En el equipo o dentro del mismo puede haber etiquetas (por ejemplo, en un variador o motor) a fin de advertir 
sobre superficies que pueden alcanzar temperaturas peligrosas.



Dónde comenzar

Siga esta ruta para completar su aplicación DataSite.

Capítulo 1
Selección de hardware

Capítulo 2
Configuración y cableado del sistema

Capítulo 3
Integración de DataSite y Logix

Capítulo 5
Integración de FactoryTalk View

Capítulo 6
Validación del sistema

Capítulo 4
Integración de DataSite Workbench y DataSite Screen Builder
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Dónde comenzar
Configuraciones DataSite

Esta guía de inicio rápido muestra cómo instalar y configurar tres configuraciones funcionales de DataSite.

• DataSite a un ControlLogix maestro (Capítulo 1 hasta 6)
• DataSite a FactoryTalk View ME maestro (Apéndice A)
• DataSite a FactoryTalk View SE maestro con habilidad de registro de datos (Apéndice B)

Capítulo 1 al 6 describen la configuración de DataSite a ControlLogix maestro. En esta configuración, una unidad 
DataSite se comunica, mediante módems de radio RF, con un controlador ControlLogix L63 y muestra los datos de flujo 
de gas natural en un terminal PanelView Plus 1000.

DataSite a ControlLogix maestro 
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Ubicación remota

Terminal 2711P PanelView Plus 1000
con puerto Ethernet incorporado

Computadora

Conmutador Ethernet

Controlador 1756-L63 ControlLogix
con el módulo 1756-ENBT Ethernet/IP y ProSoft

Ubicación de la computadora principal

Radio

Todos los dispositivos se conectan al conmutador Ethernet mediante cables Ethernet normales.
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Dónde comenzar
La configuración de DataSite a FactoryTalk View ME maestro es adecuada para aplicaciones pequeñas que no requieren 
que un controlador ControlLogix encueste (poll) múltiples unidades DataSite. El terminal PanelView Plus 600 se 
comunica con la unidad DataSite mediante comunicación en serie Modbus.

DataSite a FactoryTalk View ME maestro

La configuración de Factory Talk View SE maestro es adecuada para aplicaciones pequeñas que no requieren un 
controlador ControlLogix, pero que sí requieren habilidad de registro de datos. La computadora industrial que ejecuta 
FactoryTalk View SE se comunica con la unidad DataSite mediante comunicación Modbus TCP/IP Ethernet.

DataSite a FactoryTalk View SE maestro

Cable en serie 2711-NC13

Terminal 2711P PanelView Plus 600 

1758-FLO302 Datasite

Computadora industrial 6181P que ejecuta 
FactoryTalk View SE
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Dónde comenzar
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Prefacio

Acerca de esta publicación Esta guía de inicio rápido proporciona instrucciones paso a paso sobre cómo 
instalar y configurar tres configuraciones funcionales de DataSite.

• DataSite a un ControlLogix maestro (Capítulo 1 hasta 6)
• DataSite a FactoryTalk View Machine Edition (ME) maestro (Apéndice 

A)
• DataSite a FactoryTalk View Site Edition (SE) maestro con capacidades 

de registro de datos (Apéndice B)

Los ejemplos están diseñados para realizar la instalación de los dispositivos y su 
comunicación entre sí, de la manera más sencilla posible. La programación no es 
compleja y ofrece soluciones fáciles para verificar que los dispositivos estén 
comunicándose correctamente.

Para asistir en el diseño y en la instalación de su configuración DataSite, se 
proporcionan archivos de aplicación y otra información en el CD DataSite 
Accelerator Toolkit, publicación IASIMP-SP011. Este CD proporciona 
esquemas CAD para la configuración y el cableado del panel, programas de 
control Logix de base, archivos de aplicación FactoryTalk View HMI, y más. Para 
obtener una copia del CD, comuníquese con el distribuidor o representante de 
ventas local de Rockwell Automation. Estas herramientas y el diseño de mejores 
prácticas incorporado le permiten concentrarse en el diseño de su sistema y no en 
las tareas de tiempo de procesamiento interno del diseño. 

El comienzo de cada capítulo contiene la siguiente información. Lea estas 
secciones detalladamente antes de comenzar a trabajar en cada capítulo.

• Antes de comenzar - Esta sección indica los pasos que deben realizarse 
y las decisiones que deben tomarse antes de comenzar dicho capítulo. 
Los capítulos contenidos en esta guía de inicio rápido no tienen que 
completarse en el orden en que aparecen, pero esta sección define el 
mínimo de preparación requerido antes de completar el capítulo actual. 

• Elementos necesarios - En esta sección se enumeran las herramientas 
requeridas para completar los pasos del capítulo correspondiente. 
La misma incluye, aunque no limitativamente, hardware y software.

• Siga estos pasos - Aquí se ilustran los pasos del capítulo actual y se 
identifican los pasos requeridos para completar los ejemplos usando redes 
específicas. 

IMPORTANTE Antes de usar esta guía de inicio rápido y el contenido del CD DataSite 
Accelerator, lea Términos y condiciones en el CD.
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Prefacio
Requisitos de software Usted necesita el siguiente software para usar este juego de herramientas.

Convenciones En esta guía de inicio rápido se emplean las siguientes convenciones:

Software de Rockwell Automation Versión

DataSite Workbench 5.2

DataSite Screen Builder 1.3

DS FloConfig 1.0

RSLogix 5000 16

FactoryTalk View Studio, el cual incluye:

• Machine Edition (ME)

• Site Edition (SE)

5.0

Proposal Works 6.1

Java Runtime Environment 6, actualización 7

CD DataSite Accelerator Toolkit No se aplica

Convención Significado Ejemplo

Hacer clic Se debe hacer clic en el botón izquierdo del mouse una vez (supone que el 
cursor está ubicado sobre un objeto o una selección). Haga clic en Browse.

Hacer doble clic Se debe hacer clic con el botón izquierdo del mouse dos veces en rápida 
sucesión mientras el cursor está colocado sobre un objeto o una selección. Haga doble clic en el icono de la aplicación. 

Hacer clic con el botón 
derecho del mouse

Se debe hacer clic con el botón derecho del mouse una vez mientras el cursor 
está colocado sobre un objeto o una selección.

Haga clic con el botón derecho del mouse en el icono 
Fieldbus Networks. 

Arrastrar y colocar Presione y mantenga presionado el botón izquierdo del mouse sobre un 
objeto, mueva el cursor a donde lo desea mover y suelte el botón del mouse. 

Arrastre y coloque el bloque deseado en la ventana 
Estrategy.

Seleccionar Se debe hacer clic para resaltar un ítem del menú o una opción de una lista. Seleccione New Module de la lista desplegable.

Marcar o desmarcar Se debe hacer clic para activar o desactivar una casilla de selección. Seleccione el cuadro de verificación Disable Keying.

> Muestra selecciones de menú anidadas como el nombre del menú seguido 
de la selección del menú. Seleccione File > New.

Expandir Se debe hacer clic en el signo + a la izquierda de un ítem o de una carpeta 
específica para mostrar su contenido. Expanda Main Task. 
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Prefacio
Recursos adicionales

Puede ver o descargar las publicaciones en 
http://literature.rockwellautomation.com. Para pedir copias impresas 
de documentos técnicos, comuníquese con el distribuidor o con el representante 
de ventas local de Rockwell Automation. 

Recurso Descripción

DataSite Natural Gas Flow Meter and Remote Terminal Unit 
Installation Instructions, publicación 1758-IN001

Describe cómo instalar y cablear la unidad DataSite.

DataSite Electronic Flow Meter and Remote Terminal User Manual, 
publicación 1758-UM001

Describe cómo diseñar, instalar, programar o resolver problemas de los sistemas de control 
que utilizan controladores DataSite. 

Customized Function Blocks for DataSite Reference Manual, 
publicación 1758-RM001

Describe los bloques de función personalizados que se usan para programar las unidades 
DataSite mediante el software DataSite Workbench.

DataSite Electronic Flow Meter and Remote Terminal, Software 
User Manual, publicación 1758-UM002

Describe las herramientas de software que se usan para configurar y monitorear el controlador 
DataSite, tales como ajustes de DS, DS FloConfig y DS NP3.

http://www.ab.com/programmablecontrol/plc/datasite Proporciona información relacionada a la unidad DataSite. 

Rockwell Automation Configuration and Selection Tools, 
disponible en http://www.rockwellautomation.com/en/e-tools/

Estas herramientas en línea se instalan en su computadora personal a fin de que usted pueda 
obtener acceso rápido a la información sobre nuestros productos. 

• Proposal Works

• Industrial Computer Selector

• Operator Interface Selection Tool

• Programmable Controller Family Selector

http://www.rockwellautomation.com/solutions/integratedarchite
cture/

Proporciona información sobre las herramientas y los recursos de la Arquitectura Integrada, 
incluyendo Accelerator Toolkits. 

http://www.prosoft-technology.com/ Proporciona información respecto a productos y asistencia técnica de ProSoft Technology. 
El módulo de comunicación Modbus TCP/IP (MVI56-MNET) usado en esta guía de inicio rápido 
es un producto de ProSoft Technology.

Comuníquese con la oficina de asistencia técnica enviando un correo electrónico 
a support@prosoft-technology.com, o llame al 1 + (661) 716-5100.
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Capítulo 1

Selección de hardware

Introducción

En este capítulo usted seleccionará el hardware para sus aplicación. Puede seleccionar cualquiera de las tres 
configuraciones DataSite descritas en esta guía de inicio rápido. Dentro de cada configuración, usted tiene 
la opción de comprar un panel DataSite previamente ensamblado o uno que requiera ensamblaje. Este capítulo 
proporciona instrucciones paso a paso sobre cómo usar la lista de materiales (BOM) provista con el 
CD DataSite Accelerator Toolkit.

Antes de comenzar

Verifique que su computadora cumpla con los requisitos de software del sistema Proposal Works. 

Elementos necesarios

• CD DataSite Accelerator Toolkit, publicación IASIMP-SP011
Para obtener una copia del CD, comuníquese con el distribuidor o el representante de ventas local 
de Rockwell Automation. 

• Computadora personal con acceso a Internet para descargar el software.
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Capítulo 1       Selección de hardware
Revise las listas de componentes básicos del panel

La lista de materiales (BOM) del CD DataSite Accelerator Toolkit incluye los componentes necesarios para 
duplicar las tres configuraciones de DataSite descritas en esta guía de inicio rápido. Revise las listas de 
componentes y compárelas con las necesidades específicas de su aplicación. 

Siga estos pasos para ver la lista de materiales del CD DataSite Accelerator Toolkit para la configuración 
del DataSite al ControlLogix maestro.

1. Inicie el CD DataSite Accelerator Toolkit.

2. Seleccione DataSite Development Tools.

3. Seleccione DataSite to ControlLogix 
Master>Bill of Material, luego haga doble clic en 
DataSite_to_CLX.prp.
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Selección de hardware        Capítulo 1
Se inicia Proposal 
Works y muestra la lista 
de materiales para la 
configuración
del DataSite a 
ControlLogix maestro.

4. Revise la lista de 
materiales y haga las 
modificaciones según 
las necesidades de su 
aplicación. 

5. Después de finalizar la lista de 
materiales, haga clic en el 
icono Word de la barra de 
herramientas para convertir la 
lista de materiales en un 
documento Word. 
Word activa y muestra la lista 
de materiales. 

6. Repita los pasos del 2 al 5 para ver las listas de materiales para las otras dos configuraciones de DataSite. 

• DataSite Development Tools>DataSite to FactoryTalk View ME Master>Bill of Material>DataSite_to 
ME_.prp.

• DataSite Development Tools>DataSite to FactoryTalk View SE Master>Bill of 
Material>DataSite_to_SE.prp.

SUGERENCIA Haga doble clic en un número de pieza resaltado en negrita para iniciar el 
configurador donde usted puede modificar los componentes de la lista de 
materiales. 
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Capítulo 2

Configuración y cableado del sistema

Introducción

En este capítulo usted planea el cableado y el esquema de panel de su sistema DataSite. Puede usar los esquemas 
eléctricos AutoCAD suministrados en el CD DataSite Accelerator Toolkit para añadir o retirar componentes en 
su sistema DataSite. 

Antes de comenzar

Complete la selección de hardware de su sistema (Capítulo1).

Elementos necesarios

• CD DataSite Accelerator Toolkit, publicación IASIMP-SP011
Para obtener una copia del CD, comuníquese con el distribuidor o el representante de ventas local 
de Rockwell Automation.

• Software eléctrico AutoCAD para abrir archivos DWG o DXF.

• Software Adobe Acrobat Reader para abrir archivos PDF
• System Design for Control of Electrical Reference Manual, publicación GMC-RM001
• Documentación para los otros productos de Allen-Bradley

Vaya a Literature Library en http://literature.rockwellautomation.com para obtener acceso a las 
publicaciones de Rockwell Automation.

SUGERENCIA Use el software AutoCAD Electrical para aprovechar las características avanzadas del proyecto.
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Siga estos pasos

Revise las conexiones de DataSite

página 20

página 24

página 19

Planifique la configuración y el 
cableado de panel de su sistema 

Descargue otros esquemas CAD de 
Allen-Bradley

Verificación de su esquema de panel 
básico

página 18

Revise las conexiones de DataSite

Ítem Descripción Ítem Descripción

1 Entradas discretas y conectores para activación 6 Conector RS-485 COM 1

2 Indicadores de estado 7 Conectores de salida discreta

3 Conector Ethernet 8 Conectores de entrada de alimentación eléctrica y de entrada 
analógica

4 Conector RS-232 COM 2 9 Conductores del protocolo de transductor remoto direccionable en 
red, de entrada de impulso y de salida analógica

5 Conector RS-232 COM 1 10 Interruptores de filtro de entrada de impulso
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Planifique la configuración y el cableado de panel de su sistema DataSite

El CD DataSite Accelerator Toolkit incluye archivos de proyecto AutoCAD Electrical que incluyen diagramas de 
cableado y esquema de panel que usted puede modificar fácilmente para su aplicación específica. Hay archivos 
DWG, DXF y PDF individuales disponibles para uso en paquetes de software de esquemas e imágenes AutoCAD 
y otros. Los esquemas están diseñados para optimizar el espacio del panel y minimizar el ruido eléctrico. 

Siga estos pasos para cargar archivos CAD desde el CD DataSite Accelerator Toolkit.

1. En el CD del toolkit, seleccione DataSite Development Tools.

2. Seleccione DataSite to ControlLogix Master>AutoCAD Electrical CAD.

3. Abra la carpeta DWG o DXF.

4. Use el programa CAD para abrir los archivos DWG o DXF. 

5. Identifique necesidades de configuración adicionales específicas para su aplicación. 

6. Repita los pasos del 2 al 5 para ver los archivos CAD para las otras dos configuraciones de DataSite.
• DataSite to FactoryTalk View ME Master>AutoCAD Electrical CAD
• DataSite to FactoryTalk View SE Master>AutoCAD Electrical CAD

SUGERENCIA El archivo PDF contiene la misma información que los archivos DXF y DWG individuales. Use Adobe 
Acrobat Reader para abrir el archivo PDF. 
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Verificación de su esquema de panel básico

El proyecto AutoCAD Electrical incluye configuraciones de panel y diagramas de cableado para cada una de las 
tres configuraciones de DataSite. Añada o retire componentes según sea necesario. 

Configuraciones de panel para la configuración de DataSite a ControlLogix maestro

La configuración de DataSite a ControlLogix maestro incluye configuraciones de panel para ubicaciones de la 
computadora principal y remotas. Consulte la lista de materiales que figura debajo de cada configuración para 
repasar los ítems en cada panel. 

Ubicación del DataSite principal - Esquema de panel

Ejemplo de lista de materiales - Esquema de panel de DataSite principal
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Ubicación del DataSite remoto - Esquema de panel

Ejemplo de lista de materiales - Ubicación de DataSite remoto
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Diagramas de cableado para la configuración de DataSite a ControlLogix maestro 

El proyecto AutoCAD Electrical incluye diagramas de cableado para cada una de las tres configuraciones 
de DataSite. El ejemplo muestra el cableado de alimentación eléctrica para la configuración de DataSite a 
ControlLogix maestro. Añada o retire componentes según sea necesario.

Ejemplo de diagrama de cableado CAD
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Descargue otros esquemas CAD de Allen-Bradley

Siga estos pasos para descargar otros esquemas CAD de productos Allen-Bradley.

1. Abra el explorador y vaya a http://ab.com/e-tools.

Se abre la página web Configuration and Selection Tools.

2. Si no conoce el número de catálogo completo, 
haga clic en Product Directory para examinar 
los productos de Rockwell Automation 
configurados. 

3. Haga clic en Rockwell Automation y siga los 
comandos.

SUGERENCIA Si conoce el número de catálogo completo de su producto Allen-Bradley, puede ingresarlo aquí y luego hacer clic en Submit. 
Sin embargo, necesita una cadena completa de número de catálogo para obtener los resultados de la configuración. 
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Capítulo 3

Integración de DataSite y Logix

Introducción

En este capítulo usted configura la unidad DataSite, descarga el programa de usuario ControlLogix, configura 
el módulo de comunicación ProSoft (MVI56-MNET) Modbus TCP/IP y conecta todos los dispositivos 
del sistema.

Antes de comenzar

• Complete la selección de hardware de su sistema (Capítulo1).
• Complete la configuración y el cableado de su sistema (Capítulo2).
• Cargue todo el software DataSite en su computadora, como se indica en la página 10 del Prefacio. 

En este capítulo, usted usará el software DS FloConfig y RSLogix 5000.
• Asigne direcciones IP a todos los dispositivos en la red. La tabla lista las direcciones IP usadas en esta

guía de inicio rápido. 

Este capítulo asigna direcciones IP al módulo 1756-ENBT Ethernet, a la unidad DataSite y al módulo 
Prosoft MV156-MNET. Para obtener información detallada sobre cómo asignar una dirección IP al 
terminal PanelView Plus, consulte el documento PanelView Plus Terminals User Manual, publicación 
2711P-UM001. Para otros dispositivos, consulte el manual del usuario del fabricante. 

Elementos necesarios

• Computadora personal o computadora portátil
• Hardware:

– Unidad 1758-FLOxxx DataSite
– Controlador 1756-L63 ControlLogix
– Módulo 1756-ENBT EtherNet/IP

Dispositivo Dirección IP Dispositivo Dirección IP

Módulo 1756-ENBT Ethernet 192.168.10.90 Módulo ProSoft MV156-MNET 192.168.10.94

Radio maestro 192.168.10.91 Computadora personal 192.168.10.95

Radio remoto 192.168.10.92 Terminal PanelView Plus 1000 192.168.10.96

Unidad DataSite 192.168.10.93
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– Módulo de comunicación Modbus TCP/IP (MV156-MNET) de ProSoft Technology
– Terminal PanelView Plus 1000
– Dos radios Ethernet RF
– Cable en serie de módem nulo 1747-CP3
– Un cable cruzado Ethernet
– Cinco cables Ethernet normales 
– Conmutador Ethernet

• Software:
– Software DS FloConfig
– Software RSLogix 1000
– CD DataSite Accelerator Toolkit, publicación IASIMP-SP011

Siga estos pasos

página 42

Configure la unidad DataSite

Configure las propiedades del 
controlador ControlLogix

página 27

página 32

página 31

Cargue y abra el archivo de 
aplicación Logix

Configuración del controlador Logix

Guarde y descargue su programa

página 34

página 33

Configure la comunicación 
ControlLogix

Configure el módulo ProSoft 
Modbus

página 36

Conexión de todos los dispositivos
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Configure la unidad DataSite

Los parámetros de comunicación para la unidad DataSite se configuran mediante el software DS FloConfig. 
La unidad DataSite puede comunicarse mediante su puerto en serie o Ethernet. Esta guía de inicio rápido utiliza 
el puerto en serie para asignar a la unidad DataSite una dirección IP de 192.168.10.93 y luego cambia a 
comunicación Ethernet. 

Siga estos pasos para asignar una dirección IP, 192.168.10.93, y configure la comunicación Ethernet para 
la unidad DataSite. 

1. Conecte un cable en serie 
1747-CP3 (módem nulo) 
entre el puerto en serie de su 
computadora y el puerto 
COM2 en la unidad 
DataSite.

2. Conecte alimentación 
eléctrica de 12 VCC a la 
unidad DataSite. 

3. Inicie el software DS 
FloConfig.

La ruta mostrada puede ser 
diferente en su computadora, 
según dónde esté instalado 
el software. 

4. Seleccione New Project y haga 
clic en OK.

SUGERENCIA Asegúrese de que su computadora de escritorio o portátil tenga una dirección IP asignada, donde los primeros tres octetos 
sean los mismos que para la unidad DataSite, 192.168.10.XX. En esta guía de inicio rápido, la computadora utiliza una 
dirección IP estática de 192.168.10.95 con una máscara de subred de 255.255.255.0.

Cable en serie de módem nulo 1747-CP3

Puerto en serie COM2 Puerto en serie

192.168.10.93 192.168.10.95
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5. Inicie un nuevo proyecto. 
a. Asigne un nombre 

de proyecto. 
b. Asigne el directorio donde 

desee guardar el proyecto. 
En este ejemplo, el proyecto se 
guarda en el directorio 
predeterminado. 
c. Haga clic en Create.

6. Haga clic en PC 
Communication.
a. Seleccione COM1 en la 

lista desplegable Type 
Select.

b. Haga clic en Apply.
Aparece el mensaje 
Communication port opened 
successfully.
c. Haga clic en OK.
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7. Haga clic en Flo 
Communication, luego haga 
clic en Upload.
La pantalla se actualiza con la 
dirección IP existente y con la 
configuración del puerto en 
serie. 

8. Haga clic en OK cuando 
aparezca Upload Successful.

9. Bajo Ethernet: 
a. Escriba la dirección IP para 

la unidad DataSite. 
En este ejemplo se utiliza 
192.168.10.93.

b. Haga clic en Download.
c. Haga clic en OK cuando 

aparezca el mensaje 
Download successful.

10. Desconecte y vuelva a 
conectar la alimentación 
eléctrica a la unidad DataSite. 
Debe desconectar y volver a 
conectar la alimentación 
eléctrica cuando cambie la 
dirección IP. 
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11. Haga clic en PC 
Communication.
a. Seleccione UDP o 

TCP/Server en la lista 
desplegable Type Select.

b. Escriba la dirección IP 
192.168.10.93 que acaba 
de descargar a la unidad 
DataSite.

c. Haga clic en Apply.
d. Haga clic en OK cuando 

aparezca Communication 
port opened successfully.

12. Conecte su computadora a la 
unidad DataSite por medio 
de un cable cruzado Ethernet. 

13. Haga clic en Flo 
Communication.
a. Verifique que la dirección 

IP sea 192.168.10.93.
b. Haga clic en Download.
c. Haga clic en OK cuando 

aparezca el mensaje 
Download successful.

La dirección IP de la unidad DataSite se estableció correctamente y ahora utiliza la comunicación Ethernet. 

Cable cruzado Ethernet
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Configuración del controlador Logix

El ejemplo de programa Logix en el CD DataSite Accelerator Toolkit proporciona la lógica necesaria para 
manipular los datos provenientes del módulo de comunicación Modbus TCP/IP y los pone a disposición de los 
tags del controlador ControlLogix L63.

Cargue y abra el archivo de aplicación Logix

Siga estos pasos para cargar y abrir el archivo de aplicación Logix (.acd) desde el CD DataSite Accelerator 
Toolkit.

1. En el CD del toolkit, seleccione DataSite to ControlLogix Master>Controller Program Files, luego haga 
doble clic en el archivo de aplicación DataSite_RTU.ACD.

El software 
RSLogix 5000 lanza 
y abre el archivo .acd.
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Configure las propiedades del controlador ControlLogix

Siga estos pasos para configurar el controlador ControlLogix L63.

1. Conecte la alimentación 
eléctrica al chasis 
ControlLogix.

2. Conecte su computadora y el 
módulo 1756-ENBT 
Ethernet al conmutador 
Ethernet por medio de cables 
Ethernet normales. 

3. Seleccione Controller 
Properties en el menú Edit 
para abrir el cuadro de diálogo 
Controller Properties.

4. Haga clic en la ficha General. 
a. Haga clic en el botón 

Change Controller para 
seleccionar el controlador 
que coincida con su 
hardware.
En este ejemplo se usa 
1756-L63 revisión 16.

b. Cambie el nombre del 
controlador si 
corresponde. 

c. En la lista desplegable 
Chassis Type, seleccione el 
número de catálogo de su 
chasis. 

d. Establezca el número de 
ranura en 0 para indicar 
que el controlador 
1756-L63 reside en la 
ranura 0.

e. Haga clic en OK.

Cables Ethernet normales

192.168.10.95Controlador 1756-L63 ControlLogix con el módulo
1756-ENBT Ethernet/IP

EN
BT

Pr
oS

of
t

Conmutador Ethernet

Módulo ENBT
192.168.10.90

SUGERENCIA La ranura 0 está reservada para el módulo 1756-L63. La ranura 1 está 
reservada para el módulo 1756-ENBT. La ranura 2 está reservada para el 
módulo ProSoft Modbus TCP/IP.
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Configure la comunicación ControlLogix

Este procedimiento supone que la comunicación al controlador Logix está usando el puerto Ethernet. También 
supone que su módulo 1756-ENBT Ethernet/IP ya ha sido configurado con una dirección IP de 192.168.10.90. 

Para obtener información adicional, consulte el documento ControlLogix Controllers User Manual, publicación 
1756-UM051.

Siga estos pasos para configurar la comunicación ControlLogix.

1. Abra el software RSLinx Classic, luego seleccione Configure Drivers... en el menú Communications.

Se abre la ventana Configure 
Drivers. 

2. Seleccione Ethernet devices 
de la lista desplegable.

3. Haga clic en el botón Add 
New.

4. Acepte el nombre de driver 
predeterminado, AB_ETH-1, 
o cambie el nombre y haga 
clic en OK.
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5. Asigne la dirección IP de su 
módulo Ethernet ENBT y 
haga clic en OK.

En este ejemplo se utiliza 
192.168.10.90.

6. Haga clic en Close para cerrar la ventana Configure Drivers.

7. Seleccione RSWho del menú 
Communications.

Se abre la ventana RSWho.

8. Expanda AB_ETH_1, 
Ethernet hasta que su 
controlador 1756-L63 Logix 
quede visible.

9. Verifique que puede navegar a 
su controlador Logix en la 
ranura 0.

10. Minimice la ventana RSLinx y regrese a la ventana del proyecto RSLogix 5000.

Guarde y descargue su programa

Siga estos pasos para guardar su programa y descargarlo al controlador ControlLogix.

1. Haga clic en Verify Controller en la barra de 
herramientas RSLogix 5000 para verificar el 
programa Logix. 

Si se produce algún error o alguna advertencia, éstos aparecen en la parte inferior de la pantalla. 

2. Seleccione Save en el menú File para guardar el programa. 

3. Haga clic en Who 
Active.
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4. Navegue al controlador 
1756-L63 y haga clic en el 
botón Set Project Path.

5. Verifique que el interruptor 
de llave del controlador esté 
en la posición REM (remoto). 

6. Haga clic en Download.

Se abre la ventana Download.

7. Haga clic en Download para 
enviar el programa al 
controlador 1756-L63.

8. Haga clic en No cuando haya 
concluido la descarga. 
Publicación IASIMP-QS008A-ES-P - Marzo 2009 35



Capítulo 3       Integración de DataSite y Logix
Configure el módulo ProSoft Modbus

El módulo de comunicación ProSoft MV156-MNET Modbus TCP/IP encuesta (polls) los registros Modbus 
de la unidad DataSite y pone a disposición los datos a los tags del controlador 1756-L63. El módulo Prosoft se 
desliza en la ranura 2 del chasis ControlLogix y requiere dos archivos de configuración (.cfg) para operar. 

• WATTCP.CFG asigna una dirección IP al módulo ProSoft MVI56-MNET.
• MNET.CFG define la lista de registros Modbus para lectura desde la unidad DataSite, o escritura a ésta. 

Usted descargará estos archivos de configuración desde el CD DataSite Accelerator Toolkit. 

El archivo WATTCP.CFG se modificó para asignar al módulo ProSoft MVI56-MNET una dirección IP 
de 192.168.10.94. El archivo MNET.CFG se modificó para encuestar (poll) 19 registros Modbus de gas natural 
DataSite de cada uno de los 8 tramos de medición que aparecerán en un terminal PanelView Plus 1000. 

Si es necesario, puede usar Notepad para abrir y modificar los archivos de configuración. Para obtener más 
información sobre estos archivos y cómo fueron creados, consulte el manual del usuario de MVI56-MNET en 
DSAT Common Tools>Literature and Support Info>ProSoft directory del CD del Accelerator Toolkit. Además 
de los archivos de configuración, se requiere un programa Logix (.acd) para manipular los datos Modbus escritos 
a los tags del controlador L63. Consulte la página 31 para obtener detalles sobre cómo descargar el programa 
Logix. 

IMPORTANTE Todos los dispositivos del sistema deben estar configurados y conectados 
antes de colocar el controlador en el modo Run (marcha). Si el controlador 
ya está en el modo de marcha, seleccione Offline en el menú 
Communications. 

IMPORTANTE El programa Logix .acd se descargó en la página 31 en la sección Configuración del controlador Logix. Es necesario 
descargar el programa Logix al controlador ControlLogix L63 antes de configurar el módulo Prosoft Modbus. 

SUGERENCIA Para obtener asistencia técnica para el módulo Prosoft MVI56-MNET, envíe un correo electrónico a 
support@prosoft-technology.com o llame al número de asistencia técnica 1 + (661) 716-5100 disponible en 
http://www.prosoft-technology.com/
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Siga estos pasos para descargar los archivos de configuración WATTCP.CFG y MNET.CFG del CD DataSite 
Accelerator Toolkit al módulo ProSoft Modbus.

1. En el CD del toolkit, seleccione DataSite to ControlLogix Master>ProSoft Interface Module Files, y luego 
copie los archivos MNET.CFG y WATTCP.CFG a su escritorio.

2. Instale el módulo ProSoft 
Modbus en la ranura 2 del 
chasis Logix. 
En esta guía de inicio rápido 
se usa la ranura 2. Si usted 
cambia el número de ranura, 
debe modificar el programa 
.acd Logix. 

3. Conecte la alimentación 
eléctrica al chasis. 

4. Conecte el cable en serie 
despachado con el modulo 
ProSoft entre el puerto en 
serie de su computadora y el 
puerto (RJ45) CFG en el 
módulo ProSoft.

Al puerto CFG
(RJ45)

Ranura 2

Cable despachado con el módulo ProSoft

192.168.10.95Módulo ProSoft, ranura 2
192.168.90.94

EN
BT

Pr
oS

of
t

Al puerto en serie COM

SUGERENCIA Desconecte el cable en serie que usó previamente para conectar su 
computadora a la unidad DataSite.
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5. Seleccione Start>Programs>Accessories>Communications>HyperTerminal para abrir el hiper terminal en 
su escritorio.

6. Haga clic en No si aparece 
este cuadro de diálogo. 

7. Introduzca un nombre para la 
nueva conexión y haga clic en 
OK.

8. Seleccione el puerto COM 
que usa su computadora y 
haga clic en OK. 
En este ejemplo se utiliza 
COM1.
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9. Establezca la configuración 
del puerto COM1 como se 
muestra, y haga clic en OK.

10. Presione Shift+? para que 
aparezca el menú de 
MVI56-MNET.

11. Presione R, luego presione Y 
para transferir el archivo 
MNET.CFG.

12. En el menú Transfer, 
seleccione Send File.

SUGERENCIA Después de presionar Y, cuenta con tiempo limitado para 
buscar el archivo antes de sobrepasar el tiempo de espera. 
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13. Desde el cuadro de diálogo 
Send File:

a. Haga clic en Browse para 
ubicar el MNET.CFG, 
luego haga clic en Open.

b. Seleccione Zmodem en la 
lista Protocol.

c. Presione Send.

Una barra de avance muestra 
el estado de la transferencia 
de archivo. 

14. Presione Shift+? para 
regresar al menú principal. 

15. Presione Shift+@, luego 
Shift+? para que aparezca el 
menú Network. 

16. Presione R, luego Y para 
transferir WATTCP.CFG. 

17. En el menú Transfer, 
seleccione Send File.

SUGERENCIA Después de presionar Y, cuenta con tiempo limitado para buscar el archivo 
antes de sobrepasar el tiempo de espera.
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18. Desde el cuadro de diálogo 
Send File:

a. Haga clic en Browse para 
ubicar el WATTCP.CFG, 
luego haga clic en Open.

b. Seleccione Zmodem en la 
lista Protocol.

c. Presione Send.

Una barra de avance muestra 
el estado de la transferencia.

19. Presione Shift+? para que 
aparezca el menú Network, 
luego presione M seguido por 
Shift+? para regresar al menú 
principal.

Ya está configurado el módulo 
ProSoft Modbus.

20. Cierre el cuadro de diálogo 
HyperTerminal.

21. Desconecte y vuelva a 
conectar la alimentación 
eléctrica al módulo ProSoft; 
para ello extráigalo del chasis 
y vuelva a insertarlo.

Con ello se registra la nueva 
dirección IP. 
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Conexión de todos los dispositivos

En este punto todos los dispositivos deben estar conectados, como se muestra en la ilustración. Modifique toda 
conexión previa, si es necesario, para que coincidan con la ilustración. 

Debe usar un cable cruzado Ethernet para conectar la unidad DataSite al radio. El cable entre el conmutador 
Ethernet y el módulo ProSoft MVI56-MNET Modbus debe conectarse al puerto RJ45 Ethernet; no al puerto 
CFG. 

La configuración de los módems de radio Ethernet no se describe en esta guía de inicio rápido. Consulte el 
manual del usuario de su radio para obtener instrucciones sobre cómo configurar y asignar direcciones IP a 
ambos radios. Cuando termine con el cableado, conecte la alimentación eléctrica a todos los dispositivos. 

SUGERENCIA Los radios son opcionales. Si su aplicación no requiere radios, simplemente reemplace los radios con un 
cable Ethernet normal que conecte la unidad DataSite al conmutador Ethernet.

Terminal 2711P PanelView Plus 1000
con puerto Ethernet incorporado

Computadora portátil

Conmutador Ethernet

Radio
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rn
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Capítulo 4

Integración de DataSite Workbench y DataSite Screen Builder

Introducción

En este capítulo usted descarga el ejemplo de programa de usuario DataSite Workbench y ejemplos de páginas 
web de DataSite Screen Builder a la unidad DataSite.

Antes de comenzar

• Complete la selección de hardware de su sistema (Capítulo 1).
• Complete la configuración y el cableado de su sistema (Capítulo 2).
• Complete la integración de DataSite y Logix (Capítulo 3).
• Verifique que todos los dispositivos estén correctamente conectados y activados. 

Elementos necesarios

• Computadora personal
• Todos los dispositivos del sistema correctamente conectados y activados
• Hardware: Unidad DataSite
• Software:

– DataSite Workbench 5.2
– DataSite Screen Builder 1.3
– CD DataSite Accelerator Toolkit, publicación IASIMP-SP011
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Siga estos pasos

página 45

página 49

Descargue el programa de usuario 
de DataSite

Descargue las páginas web 
DataSite
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Descargue el programa de usuario de DataSite

Siga estos pasos para compilar y descargar el ejemplo de programa de usuario de DataSite. 

1. Inicie el software DataSite Workbench 5.2.

2. En el menú Project/Library, 
seleccione Open.

3. Seleccione la carpeta Prj en la 
lista desplegable Look in: 

4. Haga doble clic en la carpeta 
DataSite_Base_Program.

Si no aparece este cuadro de 
diálogo, consulte la sugerencia. 

SUGERENCIA Si no ve la carpeta DataSite_Base_Program en el paso 4, siga estos pasos. 

• Desde el CD DataSite Accelerator Toolkit, navegue a DSAT Common Tools>DataSite User Programs.

• Copie y pegue la carpeta DataSite_Base_Program al directorio de proyecto predeterminado de DataSite Workbench: C:\Documents 
and Settings\All Users\Documents\DataSite\Projects\Workbench 5.2\prj o bien
C:\Documents and Settings\All Users\Shared Documents\DataSite\Projects\Workbench 5.2\prj 

• Ahora regrese al paso 2 para abrir el proyecto. 
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5. Hable doble clic en PrjLibary.mdb para abrir el programa de usuario. 

6. Haga clic en el botón 
Hardware Architecture.

7. Haga doble clic en la barra Vertical Network, luego ingrese la dirección IP de la unidad DataSite y haga clic 
en OK. 
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8. Haga clic en el botón Link 
Architecture.

9. Haga clic en Rebuild Project/Library.

10. Verifique que no haya errores.

11. Haga clic en el botón Download para descargar el programa a la unidad DataSite.

12. Haga clic en Select All, luego 
haga clic en Download.
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El programa de usuario de DataSite Workbench ha sido descargado y se está ejecutando en la unidad DataSite.

SUGERENCIA Si la unidad DataSite está ejecutando un programa, verá un mensaje similar 
al siguiente. Haga clic en Stop and Download para completar el proceso de 
descarga.
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Descargue las páginas web DataSite

Usted ahora compilará y descargará los ejemplos de páginas web DataSite a la unidad DataSite. 

Siga estos pasos para descargar las páginas web HiBeam.

1. Inicie el software DataSite Screen Builder 1.3.

2. En el menú File, seleccione 
Open.

3. Seleccione la carpeta Prj en la 
lista desplegable Look in: 

4. Haga doble clic en la carpeta 
DataSite_Web_Pages.

Si no aparece este cuadro de 
diálogo, consulte la sugerencia. 

SUGERENCIA Si no ve la carpeta DataSite_Base_Web_Pages en el paso 4, siga estos pasos. 

• Desde el CD DataSite Accelerator Toolkit, navegue hasta DSAT Common Tools>DataSite Web Pages. 

• Copie y pegue la carpeta DataSite_Base_Web_Pages en el directorio de proyecto predeterminado de DataSite ScreenBuilder: 
C:\Documents and Settings\All Users\Documents\DataSite\Projects\ScreenBuilder 1.3\prj o bien
C:\Documents and Settings\All Users\Shared Documents\DataSite\Projects\ScreenBuilder 1.3\prj 

• Ahora regrese al paso 2 para abrir el proyecto. 
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5. Haga doble clic en 
DataSite_Base_Web_Pages.HAD 
para abrir el programa de páginas web. 

6. En la barra de herramientas, 
seleccione Project>Settings.

7. En la ficha Project, haga clic 
en el botón Path.

8. Navegue al directorio de 
proyecto predeterminado 
DataSite Workbench. 

9. Haga doble clic en la carpeta 
DataSite_Base_Program.

10. Haga doble clic en 
PrjLibrary.mdb, luego haga 
clic en el botón Update 
connection informations 
from project.

Esto permite que las páginas 
web DataSite obtengan 
acceso a las variables creadas 
en el ejemplo de programa de 
usuario de DataSite 
Workbench.

Directorio de proyecto predeterminado de DataSite Workbench:
C:\Documents and Settings\All Users\Documents\DataSite\Projects\Workbench 5.2\Prj o bien
C:\Documents and Settings\All Users\Shared Documents\DataSite\Projects\Workbench 5.2\Prj

Paso 8

Paso 9

Paso 10
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11. Haga clic en la ficha 
Data Servers.

a. Haga doble clic en el 
renglón para seleccionar la 
dirección IP de la unidad 
DataSite.

b. Haga clic en OK.

12. Haga clic en el botón 
Compile. 

13. Verifique que no haya errores.

14. Haga clic en el botón 
Download. 

15. Haga clic en Options.
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16. Seleccione Send Java Classes 
y haga clic en OK. 

17. Cargue las páginas web. 

a. Seleccione la dirección IP 
de la unidad DataSite.

b. Haga clic en el botón Load.
Espere dos a tres minutos 
hasta que concluya el 
proceso de descarga.

c. Haga clic en Close cuando 
vea el mensaje Connection 
OK. 

Las páginas web de DataSite han sido descargadas correctamente a la unidad DataSite. Consulte el Capítulo 6 
para obtener información sobre la validación del sistema y una descripción general de las páginas web de 
DataSite. 

SUGERENCIA Sólo es necesario seleccionar el cuadro Send JAVA classes la primera vez que 
se descarga un proyecto. Las descargas posteriores no requieren que se 
seleccione este cuadro. 
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Capítulo 5

Integración de FactoryTalk View

Introducción

En este capítulo usted descarga el proyecto FactoryTalk View ME a un terminal PanelView Plus 1000 conectado 
a un controlador ControlLogix 1756-L63. 

Antes de comenzar

• Complete la selección de hardware de su sistema (Capítulo 1).
• Complete la configuración y el cableado de su sistema (Capítulo 2).
• Complete la integración de DataSite y Logix (Capítulo 3).
• Complete la integración de DataSite Workbench y DataSite Screen Builder (Capítulo 4).
• Verifique que todos los dispositivos estén correctamente conectados y activados como se muestra en 

Conexión de todos los dispositivos en la página 42.

Elementos necesarios

• Computadora personal
• Terminal PanelView Plus 1000 con firmware versión 5.0
• Software:

– Software FactoryTalk View ME
– CD DataSite Accelerator Toolkit
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Siga estos pasos

Cargue y restaure la aplicación FactoryTalk View ME

Siga estos pasos para cargar y restaurar la aplicación FactoryTalk View Machine Edition (ME) del CD DataSite 
Accelerator Toolkit por medio de Application Manager.

1. En el CD del Toolkit, seleccione DataSite to ControlLogix Master>HMI Application Files, luego haga 
doble clic en el archivo de aplicación DataSite_ME_CLX.apa.

página 54

Cargue y restaure la aplicación 
FactoryTalk View ME

página 56

página 59

página 61

página 64

Configure la comunicación 
local

Configure la comunicación 
objetivo

Descargue el proyecto al 
terminal PanelView Plus

Ejecute el proyecto en el terminal 
PanelView Plus
54 Publicación IASIMP-QS008A-ES-P - Marzo 2009



Integración de FactoryTalk View        Capítulo 5
Se abre la ventana Application 
Manager.

2. Seleccione Restore the 
FactoryTalk View Machine 
Edition application y haga 
clic en Next.

3. Escriba DataSite_ME_CLX 
como nombre de la aplicación 
y haga clic en Finish.

Se cierra la ventana 
Application Manager después 
de que restaura la aplicación.
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Configure la comunicación local

La ficha Design (Local) del menú Communications Setup refleja la visualización de la topología del servidor 
RSLinx Enterprise en la computadora de desarrollo. En este ejemplo, la computadora de desarrollo se está 
comunicando con un controlador ControlLogix L63 mediante comunicación Ethernet.

Siga estos pasos para configurar la comunicación local.

1. Conecte la alimentación eléctrica al controlador ControlLogix L63.

2. Verifique todas las conexiones de cables como se muestra en el diagrama de cableado en la página 42.

3. Inicie el software FactoryTalk 
View Studio.

Si aparece este diálogo, 
seleccione Machine Edition y 
haga clic en Continue.
56 Publicación IASIMP-QS008A-ES-P - Marzo 2009



Integración de FactoryTalk View        Capítulo 5
4. Seleccione 
DataSite_ME_CLX en la 
ficha Existing y haga clic en 
Open.

Se abre la aplicación Machine 
Edition.

5. Expanda RSLinx Enterprise 
en la ventana Explorer.

6. Haga doble clic en 
Communication Setup. 
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Se abre la ventana Communication Setup.

7. Seleccione L63 bajo Device Shortcuts.

8. Haga clic en Remove y luego haga clic en Yes para verificar la eliminación del acceso directo.

9. Expanda el árbol RSLinx Enterprise para obtener acceso a su controlador 1756-L63 en la ranura 0 
(0, 1756-L63). 

10. Haga clic en Add bajo Device Shortcuts.

11. Asigne L63 como nombre del acceso directo y presione Enter.

12. Seleccione su controlador Logix 0, 1756-L63.

13. Haga clic en Apply bajo Device Shortcuts.

14. Haga clic en Yes para aplicar los 
cambios.
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Configure la comunicación objetivo

La ficha Runtime (Target) muestra la configuración fuera de línea desde la perspectiva del dispositivo que está 
ejecutando la aplicación y comprende la topología cargada en el terminal PanelView Plus. En este ejemplo, el 
terminal PanelView Plus se comunica con el mismo controlador
ControlLogix L63 mediante comunicación Ethernet. 

Siga estos pasos para configurar la comunicación objetivo.

1. Seleccione la ficha Design (Local) en la ventana Communication Setup.

2. Haga clic en Copy from Design to Runtime.

Un cuadro de diálogo le indica que 
confirme la operación.

3. Haga clic en Yes.
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4. Seleccione la ficha Runtime (Target) y expanda el árbol RSLinx Enterprise.

5. Haga clic en el acceso directo L63 para verificar que su controlador y el nombre del acceso directo estén 
resaltados. 

En este ejemplo, 1756-L63 es el controlador en la ranura 0 y L63 es el nombre del acceso directo. 

6. Haga clic en OK en la esquina inferior derecha de la 
ventana. 
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Descargue el proyecto al terminal PanelView Plus

Siga estos pasos para crear un archivo en tiempo de ejecución FactoryTalk View ME y descárguelo al terminal 
PanelView Plus.

1. Seleccione Create Runtime 
Application en el menú 
Application.

Se abre el cuadro de diálogo 
Create Runtime Application.

2. Seleccione Runtime 5.0 
Application (*.mer) en la lista 
Save as type.

3. Escriba 
DataSite_ME_CLX.mer en 
el campo File name.

4. Haga clic en Save y espere a 
que termine la barra de 
avance. 

5. Haga clic en el botón File 
Transfer Utility de la barra de 
herramientas.
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Se abre la ventana Transfer Utility.

6. Haga clic en el botón Browse ... para ubicar el archivo en tiempo de ejecución. 

7. Seleccione 
DataSite_ME_CLX.mer en la 
carpeta Runtime.

8. Haga clic en Open.

Ruta de la carpeta Runtime predeterminada:
C:\Documents and Settings\All Users\Documents\RSView Enterprise\ME\Runtime
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9. Examine y seleccione su terminal PanelView Plus, luego haga clic en Download.

10. Haga clic en OK cuando haya 
concluido correctamente la 
descarga.

11. Haga clic en el Exit para 
cerrar File Transfer Utility.

12. Seleccione Exit en el menú 
File para cerrar el software 
FactoryTalk View Studio.

SUGERENCIA Si el terminal PanelView Plus tiene un archivo .mer existente con el mismo nombre, haga clic en Yes para 
sobrescribir el archivo. 
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Ejecute el proyecto en el terminal PanelView Plus

El archivo (.mer) ahora está almacenado en el terminal PanelView Plus, así que usted está listo para ejecutar el 
proyecto en el terminal. 

Siga estos pasos para ejecutar su proyecto en el terminal PanelView Plus.

1. Verifique que el PanelView 
Plus esté conectado como se 
muestra en la página 42 y que 
esté recibiendo alimentación 
eléctrica.

2. Presione Load Application 
[F1] en el cuadro de diálogo 
FactoryTalk View ME 
Station.

Se abre el cuadro de diálogo 
Load Application.

3. Use las flechas hacia 
arriba/hacia abajo para 
desplazarse por la lista de 
aplicaciones y seleccione 
DataSite_ME_CLX.mer.

4. Presione Load [F2].
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5. Presione Yes [F7].

Si presiona No, se usan los 
ajustes de comunicación del 
proyecto ejecutado 
previamente.

6. Espere a que se cargue la 
aplicación y verifique que 
DataSite_ME_CLX.mer 
aparezca debajo de Current 
application.

7. Presione Run Application 
[F2].

Se crea la aplicación y aparece la pantalla DataSite en el terminal PanelView Plus.

Consulte el Capítulo 6 para obtener información sobre la validación del sistema. 
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Capítulo 6

Validación del sistema

Introducción

En este capítulo usted valida el sistema DataSite verificando que todos los datos de flujo AGA puedan verse en el 
terminal PanelView Plus 1000 y en las páginas web DataSite.

Antes de comenzar

• Complete la selección de hardware de su sistema (Capítulo 1).
• Complete la configuración y el cableado de su sistema (Capítulo 2).
• Complete la integración de DataSite y Logix (Capítulo 3).
• Complete la integración de DataSite Workbench y DataSite Screen Builder (Capítulo 4).
• Complete la integración de FactoryTalk View (Capítulo 5).
• Verifique que todos los dispositivos estén correctamente conectados y activados como se muestra en 

Conexión de todos los dispositivos en la página 42.

Elementos necesarios

• Computadora personal
• Todos los productos de hardware de los capítulos anteriores
• Software:

– DS Flo Config
– DataSite Workbench
– RSLogix 5000
– Java Runtime Environment, versión 6, actualización 7
– CD DataSite Accelerator Toolkit, publicación IASIMP-SP011
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Siga estos pasos

Valide la comunicación DataSite a 
PanelView Plus

Valide las páginas web 
DataSite

página 69

página 75

Revise el programa de usuario de 
DataSite Workbench

página 80
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Valide la comunicación DataSite a PanelView Plus

Ahora usted está listo para validar la comunicación entre la unidad DataSite y el terminal PanelView Plus. 
Por medio del software DS FloConfig, usted simula tres variables de proceso y valida que los valores de flujo 
calculados aparezcan en el terminal PanelView Plus.

Siga estos pasos para realizar la validación del sistema. 

1. Inicie el software 
DS FloConfig.

La ruta mostrada puede 
ser diferente en su 
computadora, según 
dónde esté instalado el 
software.

2. Seleccione Open Recent 
Project y haga clic en OK.

Este archivo DS FloConfig fue creado en el Capítulo 1.

SUGERENCIA Para usar las variables reales del proceso, cablee transmisores de temperatura, presión y presión diferencial a las entradas 
analógicas DataSite.
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3. Seleccione MeterRun0 en el lado izquierdo del cuadro de diálogo.

4. Haga clic en Calculation Test y seleccione los tres cuadros. 

a. Escriba 800 para Static Pressure.
b. Escriba 80 para Temperature.
c. Escriba 70 para Differential Pressure. 
d. Haga clic en OK.

SUGERENCIA Opcionalmente puede repetir los pasos 3 y 4 para Meter Run1 hasta Meter Run7.
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5. Haga clic en OK cuando aparezca el mensaje Download Successful.

6. Expanda Meter Run0, seleccione Field Parameters, luego haga clic en Upload.

7. Seleccione Accumulate y haga clic en Download.

8. Regrese al software 
RSLogix 5000.

9. Seleccione Online en el 
menú Communication, 
y coloque su controlador 
L63 ControlLogix en el 
modo Run (marcha). 

10. Verifique que el proyecto FactoryTalk View ME esté siendo ejecutado en el terminal PanelView Plus 1000. 

Si es necesario, consulte la página 61 para obtener instrucciones sobre cómo descargar y ejecutar el 
proyecto. 
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11. Presione Meter Run 0 en el 
terminal PanelView Plus.

12. Verifique que las variables del 
proceso de Meter Run 0 sean 
iguales que las de DS 
FloConfig en la siguiente 
página. 
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13. Presione Return to Main 
Screen en el terminal 
PanelView Plus.

Variables del proceso DS FloConfig

SUGERENCIA Puede repetir opcionalmente los pasos del 9 al 12 para validar las variables del proceso de Meter Run 1 a Meter Run 7. 
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14. Presione DS Digital Outputs 
en la pantalla principal de 
PanelView para validar el 
control de las salidas digitales 
DataSite.

15. Presione una salida digital. 

El botón pulsador de la 
izquierda activa la salida 
digital 0. 
El botón pulsador de la derecha 
activa la salida digital 1.
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Ha concluido la configuración y la validación de la unidad DataSite al ControlLogix maestro.

Valide las páginas web DataSite

Ahora debe validar las páginas web de la unidad DataSite usando los valores simulados de la sección Valide la 
comunicación DataSite a PanelView Plus en la página 69. Para ver las páginas web, debe tener la versión más 
reciente de Java Runtime Environment cargada en su computadora. El CD DataSite Accelerator Toolkit contiene 
una copia de la versión requerida de Java Runtime Environment.

Siga estos pasos para realizar la validación de las páginas web.

1. Desde el CD del Toolkit, seleccione 
DSAT Common Tools>DataSite 
Web Pages, luego haga doble clic en el 
jre-6u7-windows-i586-p.exe ejecutable, 
para cargar el sistema Java Runtime 
Environment, versión 6, actualización 7.

SUGERENCIA Para validar esta funcionalidad, debe cablear un dispositivo de prueba, tal 
como una columna luminosa a una salida digital 0 y otro dispositivo a una 
salida digital 1. También debe suministrar el voltaje requerido a los 
terminales DOV+ y DOV-. 

SUGERENCIA Puede saltar el paso 1 si la versión 6, actualización 7 de Java Runtime Environment está instalada en su computadora. 
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Capítulo 6       Validación del sistema
2. Inicie Internet Explorer.

3. En la barra Address, escriba http://192.168.10.93/datasite.html

Java requiere 
aproximadamente un minuto 
para cargar esta pantalla. 

De manera similar al terminal 
PanelView Plus, en las páginas 
web aparecen los mismos 
datos de flujo que en 
DS FloConfig.

4. Haga clic en Meter Run 0.

IMPORTANTE Debe introducir la dirección IP correcta de la unidad DataSite. En esta guía 
de inicio rápido se utiliza 192.168.10.93
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Validación del sistema        Capítulo 6
5. Verifique que las variables de proceso sean iguales que en DS FloConfig.

6. Haga clic en Main Menu para regresar a la pantalla de aplicación principal. 
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Capítulo 6       Validación del sistema
7. Haga clic en Digital Outputs.

8. Haga clic en Digital Output 2.
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Validación del sistema        Capítulo 6
9. Repita el paso anterior para 
verificar la salida digital 3. 

Ya terminó la validación de página web. Modifique los ejemplos de programa existentes de acuerdo a sus 
necesidades. Este ejemplo sólo muestra datos para un tramo de medición (Meter Run). Duplique el ejemplo para 
añadir tramos de medición adicionales. 

SUGERENCIA Para validar esta funcionalidad, debe cablear un dispositivo de prueba, tal 
como una columna luminosa a la salida digital 2 y otro dispositivo a la 
salida digital 3. También debe suministrar el voltaje requerido a los 
terminales DOV+ y DOV-. 
Publicación IASIMP-QS008A-ES-P - Marzo 2009 79



Capítulo 6       Validación del sistema
Revise el programa de usuario de DataSite Workbench

El ejemplo de proyecto de DataSite Workbench consta de cuatro programas.

• PowerSave - Ahorre alimentación eléctrica activando/desactivando los indicadores LED, el puerto en serie 
y el puerto RS485. 

• ScreenBuilderVariables - Lee las variables de datos de flujo del tramo de medición Meter Run 0 y asigna una 
variable DataSite Workbench que puede ser usada por las páginas web de DataSite.

• DigitalOutputs - Controla las salidas digital 2 y 3 de DataSite. 
• TimeSynchronization - Sincroniza el reloj de DataSite con el reloj del controlador ControlLogix L63.

Siga estos pasos para ver el programa DataSite Workbench en el modo Run (marcha). 

1. Compile el programa de usuario DataSite Workbench haciendo clic en Rebuild Project/Library.

2. Haga clic en Debug Target.

Esto le permite ver un programa en ejecución y hacer cambios en las variables.

3. En el modo Debug (depurar), haga doble clic en el programa que desee ver.

4. Consulte los comentarios del programa para obtener detalles sobre la funcionalidad. 

Para ver otros programas, cierre la ventana del editor de programa y haga doble clic en otro programa desde 
la ventana Link Architecture. 
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Apéndice A

DataSite a FactoryTalk View ME maestro

Este apéndice describe cómo configurar un terminal PanelView Plus 600 para que se comunique con la unidad 
DataSite mediante comunicación en serie Modbus. Esta comunicación requiere que KEPServerEnterprise V4.0 
configure los drivers entre la unidad DataSite y el terminal PanelView Plus que ejecuta FactoryTalk View ME.

Use esta configuración para aplicaciones de menor tamaño que no requieren un controlador ControlLogix para 
encuestar (polling) múltiples unidades DataSite. Consulte el Apéndice B para obtener instrucciones sobre cómo 
configurar un Factory Talk View SE maestro para comunicarse con la unidad DataSite mediante comunicación 
Modbus TCP/IP que no requiere un controlador pero que requiere parámetros de registro de datos a un archivo Excel. 

Antes de comenzar

• Descargue KEPServer Enterprise V4.0.
• Cablee la unidad DataSite al terminal PanelView Plus 600 con el cable en serie 2711-NC13.
• Conecte la alimentación eléctrica a la unidad DataSite y al terminal PanelView Plus 600.

Elementos necesarios

• Computadora personal
• Hardware:

– Unidad DataSite
– Terminal PanelView Plus 600
– Cable en serie 2711C-NC13
– Cable cruzado 2711P-CBL-EX04 Ethernet

Cable en serie 2711-NC13 Cable cruzado Ethernet

Computadora de programación 
que ejecuta

FactoryTalk View ME

Terminal 2711P PanelView Plus 600
con puerto Ethernet incorporado

2711P-CBL-EX04
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Apéndice A        DataSite a FactoryTalk View ME maestro
• Software:
– KEPServerEnterprise V4.0
– FactoryTalk View Studio ME
– CD DataSite Accelerator Toolkit, publicación IASIMP-SP011

Siga estos pasos

Cargue el archivo 
KEPServerEnterprise

página 83

Cargue la aplicación FactoryTalk 
View ME

página 85

Valide la comunicación entre la unidad 
DataSite y el terminal

página 88
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DataSite a FactoryTalk View ME maestro        Apéndice A
Cargue el archivo KEPServerEnterprise

Siga estos pasos para cargar un archivo KEPServer Enterprise .pfe con las direcciones Modbus de los parámetros 
que serán encuestados (polled) y mostrados en el terminal PanelView Plus 600 HMI.

1. Desde el CD DataSite Accelerator Toolkit, seleccione DataSite to FactoryTalk View ME Master>HMI 
Application files.

2. Copie ModbusSerial.pfe del CD a la carpeta predeterminada de proyecto para KEPServerEnterprise.

3. Inicie KEPServerEnterprise V4.0.

4. Seleccione Open en el menú File, luego ubique y abra el archivo ModbusSerial.pfe.

C:\Program Files\KEPServerEnterprise\Projects
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Apéndice A        DataSite a FactoryTalk View ME maestro
5. En el menú Tools, 
seleccione Options.

6. Haga clic en el botón 
Browse ... para ubicar el 
proyecto predeterminado 
ModbusSerial.pfe.

7. Haga clic en Apply.

8. Haga clic en OK.

C:\Program Files\KEPServerEnterprise\Projects\ModbusSerial.pfe
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DataSite a FactoryTalk View ME maestro        Apéndice A
Cargue la aplicación FactoryTalk View ME

La aplicación FactoryTalk View ME contiene pantallas para mostrar datos de flujo en un terminal 
PanelView Plus 600 para un tramo de medición (Meter Run).

Siga estos pasos para cargar la aplicación FactoryTalk View ME desde el CD DataSite Accelerator Toolkit.

1. En el CD del Toolkit, seleccione DataSite to FactoryTalk View ME Master>HMI Application Files, luego 
haga doble clic en DataSite_ME_Modbus_Serial.apa.

Se abre la ventana Application 
Manager.

2. Seleccione Restore the FactoryTalk 
View Machine Edition application 
y haga clic en Next.
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Apéndice A        DataSite a FactoryTalk View ME maestro
3. Escriba DataSite_ME_Modbus_Serial 
como nombre de la aplicación, luego 
haga clic en Finish.

Se cierra la ventana Application 
Manager después de que se restaura 
la aplicación.

4. Inicie el software FactoryTalk View 
Studio.

5. Si se abre este diálogo, seleccione 
Machine Edition y haga clic en 
Continue.

DataSite_ME_Modbus_Serial
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DataSite a FactoryTalk View ME maestro        Apéndice A
6. Seleccione DataSite_ME_Modbus_Serial 
en la ficha Existing y haga clic en Open.

Se abre la aplicación 
FactoryTalk View ME.

7. Cree el archivo .mer y descárguelo al terminal PanelView Plus 600.

SUGERENCIA Consulte Descargue el proyecto al terminal PanelView Plus en la página 61 para obtener detalles sobre 
cómo crear una aplicación en tiempo de ejecución y descargar el archivo de aplicación .mer al terminal 
PanelView Plus 600.
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Apéndice A        DataSite a FactoryTalk View ME maestro
Valide la comunicación entre la unidad DataSite y el terminal

Ahora usted está listo para ejecutar la aplicación .mer en el terminal PanelView Plus 600 y validar la 
comunicación con la unidad DataSite. El archivo KEPServer (.pfe) encuesta (polls) 19 parámetros para un tramo 
de medición y muestra los datos en el terminal PanelView Plus 600.

Siga estos pasos para validar la comunicación en serie Modbus entre la unidad DataSite y el terminal 
PanelView Plus 600.

1. Asegúrese de que el puerto COM1 o COM2 de la unidad DataSite esté conectado al puerto en serie 
del terminal PanelView Plus con un cable Ethernet normal 2711-NC13.

2. Desde el terminal 
PanelView Plus, presione 
Load Application [F1] en el 
cuadro de diálogo FactoryTalk 
View ME Station.

SUGERENCIA La validación supone que los cálculos AGA se iniciaron usando dispositivos de instrumentación o 
simulados en DS FloConfig. Consulte el Capítulo 6 para obtener más información sobre cómo simular las 
variables de proceso AGA. 

Cable Ethernet normal 2711-NC13

SUGERENCIA Si usa radios, conecte un radio en serie a la unidad DataSite y el otro radio 
al terminal PanelView Plus 600.
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DataSite a FactoryTalk View ME maestro        Apéndice A
Se abre el cuadro de diálogo 
Load Application.

3. Use las flechas hacia arriba/hacia 
abajo para desplazarse por la lista de 
aplicaciones y seleccione 
DataSite_ME_Modbus_Serial.

4. Presione Load [F2].

5. Presione Yes [F7].

Si presiona No, se usa la 
configuración de comunicación 
del proyecto ejecutado 
previamente. 
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Apéndice A        DataSite a FactoryTalk View ME maestro
6. Espere que se cargue la aplicación 
y verifique que 
DataSite_ME_Modbus_Serial
.mer aparezca debajo de Current 
application.

7. Presione Run Application [F2].

Se crea la aplicación y aparece la pantalla 
DataSite en el terminal PanelView Plus.

8. Presione Process Variables & 
Compressibility.

Verifique que las variables del procesos 
coincidan con los números simulados 
usando DS FloConfig:
– Presión estática = 800
– Temperatura = 80
– Presión diferencial = 70

9. Regrese a la pantalla principal y presione los otros dos botones azules para ver los datos de flujo 
acumulados. 

El dato de flujo mostrado es para Meter Run 0 (MR0). Usted puede añadir fácilmente otros tramos de medición 
añadiendo los registros Modbus correspondientes en el archivo KEPServerEnterprise (.pfe). Entonces debe 
duplicar las pantallas ME y cambiar los nombres de tag para que coincidan con sus nombres de tag 
correspondientes. 

Ha concluido la configuración y validación de la configuración DataSite a ME maestro.

IMPORTANTE Si el terminal PanelView Plus muestra asteriscos en lugar de datos, entonces usted debe seleccionar un puerto COM diferente 
para el driver DF1 en serie. Vaya a la página 91 para obtener instrucciones sobre cómo cambiar el puerto COM. 

2800

800
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DataSite a FactoryTalk View ME maestro        Apéndice A
Seleccione un puerto COM diferente para el driver DF1 en serie

Si los datos variables aparecen como asteriscos en el terminal PanelView Plus, debe cambiar el puerto COM 
usado por el driver DF1 en serie. Si los datos aparecen correctamente en el terminal, puede saltar esta sección. 

Siga estos pasos para seleccionar un puerto COM diferente para el driver DF1 en serie. 

1. Presione Terminal Settings 
[F4] en el cuadro de diálogo 
FactoryTalk View ME 
Station.

2. Seleccione Networks and 
Communications, luego 
presione el botón Enter. 
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Apéndice A        DataSite a FactoryTalk View ME maestro
3. Seleccione RSLinx Enterprise 
Communications 
presionando la tecla del 
cursor, luego presione el 
botón Enter. 

4. Seleccione Serial-DF1, luego 
presione Edit Driver [F2].
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DataSite a FactoryTalk View ME maestro        Apéndice A
5. Seleccione COM Port, luego 
presione Edit [F1].

6. Seleccione 2, luego presione 
OK [F7].
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Apéndice A        DataSite a FactoryTalk View ME maestro
7. Presione el botón Cancel [F8] 
hasta regresar al menú 
principal. 

8. Para validar la aplicación, 
repita los pasos del 2 al 8, 
comenzando en la página 88.
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Apéndice B

DataSite a FactoryTalk View SE maestro

Este apéndice muestra cómo configurar una computadora industrial que ejecuta el software FactoryTalk View SE 
para comunicarse con una unidad DataSite usando comunicación Modbus TCP/IP. Esta configuración requiere 
el software KEPServerEnterprise V4.0 para configurar el driver de comunicación. 

Esta configuración es adecuada para aplicaciones pequeñas que requieren habilidades de registro de datos pero 
que no requieren que un controlador ControlLogix encueste (poll) múltiples unidades DataSite. Consulte el 
Apéndice A para obtener detalles sobre cómo configurar un terminal PanelView Plus que ejecuta el software 
Factory Talk View ME para comunicarse con la unidad DataSite usando la comunicación en serie Modbus. 

Antes de comenzar

• Descargue el software KEPServer Enterprise V4.0.
• Conecte la unidad DataSite a una computadora industrial que ejecute el software 

FactoryTalk View Site Edition (SE). 
• Los radios son opcionales. 

Computadora industrial 6181P que ejecuta 
FactoryTalk View SE

Radio

Et
he

rn
et

Ubicación remota

Radio
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rn
et

Ubicación de la computadora principal
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do

 
27

11
P-
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X0
4
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SUGERENCIA Los radios son opcionales. Si su aplicación no requiere radios, simplemente reemplace los radios con un 
cable cruzado Ethernet que conecte la unidad DataSite a la computadora industrial. 
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Apéndice B        DataSite a FactoryTalk View SE maestro
Elementos necesarios

• Hardware:
– Unidad DataSite
– Computadora industrial 6181P o computadora personal
– Dos radios, opcionales
– Dos cables cruzados 2711P-CBL-EX04 Ethernet 

• Software:
– KEPServerEnterprise V4.0
– FactoryTalk View SE
– CD DataSite Accelerator Toolkit, publicación IASIMP-SP011

Siga estos pasos

Cargue el archivo 
KEPServerEnterprise

página 97

Cargue la aplicación FactoryTalk 
View SE

página 99

Valide la comunicación entre la unidad 
DataSite y la computadora

página 106
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DataSite a FactoryTalk View SE maestro        Apéndice B
Cargue el archivo KEPServerEnterprise

Siga estos pasos para cargar un archivo KEPServer Enterprise .pfe con las direcciones Modbus de los parámetros 
que serán encuestados (polled) y mostrados en la computadora industrial. 

1. Desde el CD DataSite Accelerator Toolkit, seleccione DataSite to FactoryTalk View SE Master>HMI 
Application files.

2. Copie ModbusEthernet.pfe del CD a la carpeta de proyecto predeterminado para KEPServerEnterprise.

3. Inicie el software KEPServerEnterprise V4.0.

4. Seleccione Open en el menú File, luego ubique y abra el archivo ModbusEthernet.pfe.

C:\Program Files\KEPServerEnterprise\Projects
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Apéndice B        DataSite a FactoryTalk View SE maestro
5. Seleccione Options en el 
menú Tools.

6. Haga clic en el botón 
Browse ... para ubicar el 
proyecto predeterminado 
ModbusEthernet.pfe.

7. Haga clic en Apply.

8. Haga clic en OK.

C:\Program Files\KEPServerEnterprise\Projects\ModbusEthernet.pfe
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DataSite a FactoryTalk View SE maestro        Apéndice B
Cargue la aplicación FactoryTalk View SE

La aplicación FactoryTalk View SE contiene una pantalla que controla cuándo comenzar y detener el registro 
de datos en un archivo Excel. También contiene una pantalla con datos de flujo de gas para el tramo de medición 
Meter Run 0. 

Siga estos pasos para cargar la aplicación FactoryTalk View SE desde el CD DataSite Accelerator Toolkit.

1. En el CD del toolkit, seleccione DataSite to FactoryTalk View SE Master>HMI Application files, luego 
haga doble clic en DataSite_SE_Modbus_Ethernet.apa file.
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Apéndice B        DataSite a FactoryTalk View SE maestro
Se abre la ventana Application 
Manager.

2. Seleccione Restore the 
FactoryTalk View SE (local) 
application y luego haga clic en Next.

3. Asigne DataSite_ME_Modbus_Ethernet 
como nombre de la aplicación, y haga clic 
en Finish.

Se cierra la ventana Application Manager 
después de que restaura la aplicación.

DataSite_ME_Modbus_Ethernet
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DataSite a FactoryTalk View SE maestro        Apéndice B
4. Inicie el software 
FactoryTalk View Studio.

5. Si se abre este diálogo, seleccione 
Site Edition (Local) y haga clic en 
Continue.

6. Seleccione 
DataSite_SE_Modbus_Ethernet en 
la ficha Existing y haga clic en Open.

Se abre la aplicación 
FactoryTalk View SE.
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Apéndice B        DataSite a FactoryTalk View SE maestro
7. Haga clic en Launch SE Client en 
la barra de herramientas.

8. Haga clic en New.

9. Haga clic en New.
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DataSite a FactoryTalk View SE maestro        Apéndice B
10. Asigne DataSite_Client como 
nombre del archivo de 
configuración, y haga clic en 
Next.

11. Seleccione Local, luego haga 
clic en Next.
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Apéndice B        DataSite a FactoryTalk View SE maestro
12. Seleccione 
DataSite_SE_Modbus_Ethernet en la 
lista desplegable, o el nombre de la 
aplicación asignado durante la 
restauración, luego haga clic en Next.

13. Seleccione Main en la lista desplegable 
Initial Display, luego haga clic en Next.
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DataSite a FactoryTalk View SE maestro        Apéndice B
14. Ingrese DataSite en Title bar 
text, y haga clic en Next.

15. Haga clic en Next.
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Apéndice B        DataSite a FactoryTalk View SE maestro
16. Seleccione Save configuration and 
open FactoryTalk View SE Client 
now, luego haga clic en Finish.

Factory Talk View SE Client inicia la 
aplicación. Continúe a la siguiente sección 
para validar la comunicación y realice el 
registro de datos. 

Valide la comunicación entre la unidad DataSite y la computadora

Ahora usted está listo para validar la comunicación entre la unidad DataSite y la computadora industrial. 

1. Presione Meter Run.
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DataSite a FactoryTalk View SE maestro        Apéndice B
Debe aparecer una pantalla 
con valores de flujo de gas 
para el tramo de medición 
Meter Run 0.

2. Verifique que las variables 
del proceso sean las 
correctas y presione Main 
Menu.

3. Presione Data Logging.

4. Presione Datalog ON.

5. Deje que el registro de datos se 
ejecute durante 
aproximadamente uno o dos 
minutos, luego presione 
Datalog OFF.
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Apéndice B        DataSite a FactoryTalk View SE maestro
6. En el CD del Toolkit, seleccione DataSite to FactoryTalk View SE Master>HMI Application files, luego 
haga doble clic en RSView Enterprise File Viewer.

7. En el menú File, seleccione Open.

8. Desplácese hacia 
abajo a la carpeta 
datalog y haga doble 
clic en ella.

Ubicación predeterminada para la carpeta datalog: 
C:\Documents and Settings\All Users\Documents\RSView Enterprise\SE\HMI 
Projects\DataSite_SE_Modbus_Ethernet\DLGLOG\datalog
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DataSite a FactoryTalk View SE maestro        Apéndice B
9. Seleccione el archivo con la fecha más reciente, donde el formato del nombre de archivo es 
AAAA MM DD 0000 (valor con punto flotante (coma flotante)).DAT.
Aparece un archivo similar a éste. 

10. En el menú File, seleccione Save As.
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Apéndice B        DataSite a FactoryTalk View SE maestro
11. Asigne un nombre de archivo, 
luego haga clic en Save.

El archivo se guarda en el 
formato .csv para 
visualización en Excel. 

12. Vaya a su escritorio y ubique el 
archivo que acaba de crear. 

13. Haga doble clic en MeterRun0_Flow_Data.csv 
para ver el dato en Microsoft Excel.

14. Vea y manipule los datos si es necesario.

Ha concluido la configuración y validación de la configuración DataSite a SE maestro.
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Servicio de asistencia técnica 
de Rockwell Automation

Rockwell Automation proporciona información técnica en la web para ayudarle a utilizar 
sus productos. En http://support.rockwellautomation.com, puede encontrar manuales 
técnicos, una base de conocimientos con respuestas a preguntas frecuentes, notas técnicas 
y de aplicación, ejemplos de código y vínculos a Service Packs de software, así como una 
función llamada MySupport que puede personalizar para sacar el máximo provecho 
de todas estas herramientas. 

Con el fin de brindarle un nivel adicional de asistencia técnica por teléfono para la 
instalación, la configuración y la resolución de problemas, ofrecemos los programas 
de asistencia técnica TechConnect Support. Si desea obtener más información, póngase 
en contacto con su distribuidor local o con un representante de Rockwell Automation, 
o visítenos en http://support.rockwellautomation.com.

Asistencia para la instalación

Si se le presenta un problema durante las primeras 24 horas de instalación, revise 
la información en este manual. También puede llamar a un número especial de asistencia 
técnica al cliente, a fin de recibir ayuda inicial para poner en marcha el producto.

Devolución de productos nuevos

Rockwell Automation prueba todos los productos para garantizar su correcto 
funcionamiento cuando salen de las instalaciones de fabricación. No obstante, si su 
producto no funcionara, y necesitara devolverlo, siga estos procedimientos.

Estados Unidos 1.440.646.3434
Lunes a viernes, 08:00 –17:00 hora oficial del Este

Fuera de los Estados 
Unidos

Comuníquese con el representante local de Rockwell Automation para cualquier 
consulta relativa a la asistencia técnica.

Estados Unidos Comuníquese con el distribuidor. Deberá proporcionar al distribuidor un número 
de caso de asistencia técnica (llame al número de teléfono proporcionado 
anteriormente para obtenerlo) a fin de completar el proceso de devolución.

Fuera de los Estados 
Unidos

Comuníquese con el representante regional de Rockwell Automation para obtener 
información sobre el procedimiento de devolución.
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